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Rear panels overview

A

O
A — Interlock safety cutout connector H-ILDA in
B — USB signal indicator I — Power input IEC connector
C — DMX signal indicator J — Control buttons
D - DMX out K — Keyswitch
E - DMXin L — ILDA out
F — 6-pin XLR connector for link to PC via M - Power on/off switch

USB adapter cable
G - Display

N — Main fuseholder



Safety Information

DANGER! CLASS 4 LASER PRODUCT

General
DANGER! This product is for professional use only! It presents risks of lethal or severe injury
due to laser radiation, fire and heat, electric shock, skin hazards and falls.

Read this manual before installing or powering the fixture, follow the safety precautions listed below and
observe all warnings in this manual and on the fixture. If you have any questions about how to operate
the fixture safely, please contact your Martin supplier or call the Martin 24-hour service hotline.

Refer all service not described in this manual to a Martin service technician.

Laser safety

This product is a Class 4 laser with more than 1000 mW visible output. This laser system presents a
hazard from direct or specular reflections, but may also produce hazardous diffuse reflections and may
present significant eye and skin hazards as well as fire hazards.

Warning! Only Laser Safety Officers who are officially certified by a regulatory body or
authorized training organization are allowed to use class 4 lasers in public. The Laser
Safety Officer is responsible for all aspects of use of this laser, including ensuring that
all locally applicable safety laws and regulations are observed.

Laser Safety is regulated by different authorities in each country:

¢ In Canada, the Radiation Protection Bureau (RPB)

¢ In the United States of America, the Center for Devices and Radiological Health [CDRH]
e In Europe, the European Norm-organization CENELEC

Refer to these institutions for detailed information about the safety regulations that apply in your country
before operating this laser. Note that if safety practices required by locally applicable law or regulations
differ from those outlined in this manual, the stricter requirement must be respected.

Caution — use of controls or adjustments or performance of procedures other than those specified
herein may result in hazardous radiation exposure.

Protecting yourself and others from electric shock and injury

e Disconnect the fixture from AC power before removing or installing a fuse or any part, and when not
in use.

e Always ground (earth) the fixture electrically.

e Use only a source of AC power that complies with local building and electrical codes and has both
overload and ground-fault (earth fault) protection.

e Do not expose the fixture to rain or moisture.
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Do not use the fixture if ambient temperature is above 40° C (104° F) or below 5° C (41° F), if relative
humidity exceeds 90%, or if condensation is forming.

If the fixture, power cable or power plug is visibly damaged in any way, cut power, disconnect it and
do not operate it until it has been repaired by Martin Service.

Use only the power cable supplied with the fixture. Replacement power cables are available from
Martin.

If the output window is not in perfect condition, for example if there are visible cracks or scratches,
disconnect the fixture from power and do not operate it until the output window has been replaced by
Martin Service.

Do not operate the fixture if any covers are open, missing or damaged in any way.

Protect your eyes with laser safety goggles that give protection from the laser output as defined in the
Specifications section of this user manual when working on or near the fixture.

Do not look directly into the output window or laser beam.

Keep fingers and objects out of the holes in the mounting bracket, as there is a risk of cutting or
shearing if the fixture moves or is adjusted in the bracket.

Keep fingers and other objects out of the cooling fans.

Protecting yourself and others from burns and fire

Ensure that people and objects cannot come closer than 2 meters (7 feet) to the fixture within a zone
of 80° x 80° around the output window.

Keep the fixture well out of reach of the public.

Keep the output window minimum 3 meters (10 feet) above the level of any floor that is accessible to
the public.

Do not illuminate any surface within 2 meters (7 feet) of the fixture

Keep combustible materials (for example fabric, wood, paper) at least 1 meter (40 inches) away from
the fixture.

Keep flammable materials well away from the fixture.
Maintain a minimum free space of 30 centimeters (12 inches) around the fixture.
Do not attempt to bypass thermal protection mechanisms or fuses.

Replace defective fuses with ones of the specified type and rating only.

Protecting yourself and others from injury due to falls

When suspending the fixture above ground level, check that the structure can hold at least 10 times
the weight of all installed devices.

Check that all external covers and rigging hardware are securely fastened and use an approved
means of secondary attachment such as a safety cable.

Block access below the work area whenever installing, servicing or removing the fixture.

Martin products are supplied in compliance with Directive 2002/96/EC of the European
Parliament and of the Council of the European Union on WEEE (Waste Electrical and
Electronic Equipment), as amended by Directive 2003/108/EC, where applicable.

Help preserve the environment! Ensure that this product is recycled at the end of its life.
Your supplier can give details of local arrangements for the disposal of Martin products
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Introduction

Thank you for selecting the Martin RGB Laser 1.6™. This laser fixture is designed to give full access to
laser light effects and projections using a regular lighting desk with DMX output or an advanced laser
controller.

The RGB Laser 1.6 is supplied with a library of standard beam and graphic effects stored in internal
memory and controllable by DMX. A PC software package supplied with the fixture allows effects to be
taken from a library or created, edited and stored in internal memory. Effects editing is intuitive and user-
friendly, with parameters, image and text editing in a familiar Windows environment. Effects can be
projected in real time by the RGB Laser 1.6 while they are edited.

The RGB Laser 1.6 also has a standard ILDA analog connection, and can be controlled using any ILDA-
compatible laser control device.

A range of fail-safe systems shut down the laser if the operator attempts to project a beam that is static
and concentrated enough to cause injury.

Features

e Direct RGB color mixing through analog modulation

e White-light laser with balanced cool white

e Adjustable white balance

e Onboard show playback system with 432 cues available
e Library of 288 cues supplied pre-installed

e Real-time effect programming, editing and viewing

e USB 2.0 PC interface

e DMX controllable

e Stand-alone demo mode with 256 cues available

e Stand-alone (autostart) mode

e Can be operated with any ILDA compatible controller

o Fail-safe laser radiation protection systems

e Temperature stabilized

e Dust-free sealed optics

e Rugged, compact design

e Auto-sensing power supply: 100-240 VAC, 50/60Hz

e Wide ambient temperature range from 5° C (41° F) non-condensing to 40° C (104° F)

¢ Rated diode life of 10 000 hours (at 80% output), giving minimal service cost and downtime

Martin Laser RGB 1.6 User Manual



Special product information

Storage temperature

Diode laser devices are subject to internal thermal stresses that have a small effect on beam precision
over time if the device is exposed to temperature fluctuation. The effect on precision is minimal: after 100
cycles of being warmed from 5°C (41°F) up to 40°C (104°F) and back again, RGB beam drift will be less
than 1% of beam diameter. However, for maximum beam precision over the RGB Laser 1.6’s lifetime,
store the fixture at room temperature and keep ambient temperature as stable as possible.

Temperature stabilization at power on

Important! When power is applied, laser output may be disabled for between 1 and 10 minutes
while diode temperature stabilizes.

When the RGB Laser 1.6 fixture is powered on, laser output is disabled and the message Warming up
appears in the display until the laser operating temperature has stabilized:

e At room temperature of 20-25°C (68-77°F), stabilization takes approximately one minute.

e At the two extremes of the ambient temperature range the fixture can operate in, i.e. at 40°C (104°F)
or 5°C (41°F), stabilization takes approximately 10 minutes.

Maximum diode lifetime is obtained if the laser is only used at stabilized operating temperature. We
therefore recommend you wait for minimum one minute after powering on before you activate the beam.

Internal memory

The RGB Laser 1.6 has 128 MB of internal flash memory available for storing cues and settings. It is
supplied with 288 cues stored in memory. Cues can be uploaded to memory using a PC running the
supplied Martin Laser Show software and connected to the RGB Laser 1.6 using the supplied USB to 6-
pin XLR adapter cable.

The internal memory uses a special file system and is supplied correctly formatted. The memory can be
reformatted using Tools - Format card... in the Martin Laser Show software, but reformatting should
only be carried out if the show software reports that there is a memory error while uploading cues.

Instructions for projecting and uploading cues are provided in the Operation section of this manual.
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Installation

Warning! Read ‘Safety Information’ on page 5 before installing the Martin RGB Laser 1.6.

Connecting to AC power

Warning! Local AC power must have both overload and ground fault (earth leakage) protection.

The RGB laser 1.6 power supply is fully auto-sensing and the fixture can be connected to AC power at
any nominal voltage from 100 - 240 VAC at 50 or 60 Hz.

Installing a power plug

Warning! For protection from dangerous electric shock, the fixture must be grounded (earthed).
Consult a qualified electrician if you have any doubts about proper installation.

The RGB Laser 1.6 is supplied with three IEC-type power cables: one with a Schuko (Euro) plug, one
with a US plug, and one with no plug.

If neither of the first two power cables matches your local power outlets, fit the third cable with a suitable
grounding-type (earthed) power plug, following the plug manufacturer’s instructions. Connect the yellow
and green wire to ground (earth), the brown wire to live, and the blue wire to neutral. The table below
shows some pin identification schemes.

Wire Pin Marking Screw color
brown live “L” yellow or brass
blue neutral “N” silver
yellow/green | ground @ green

Physical installation

The RGB laser 1.6 may be suspended at any angle from a suitable support such as a truss, placed on a
horizontal surface resting on its rubber feet, or fastened to a surface.

DANGER! Ensure that people and objects cannot come closer than 2 meters (7 feet) to the fixture
within a zone of 80° x 80° around the output window.

The RGB laser 1.6 must be positioned well out of reach of the public. The output
window must be kept minimum 3 meters (10 feet) above the level of any floor that is
accessible to the public.

Do not illuminate any surface within 2 meters (7 feet) of the fixture. Locate the fixture
at least 1 meter (4 feet) from any combustible materials (wood, fabric, paper, etc.) and
well away from any flammable materials. Leave 30 centimeters (12 inches) minimum
free space around the fixture.
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Suspending from a support

Warning! Block access below the work area and work from a stable platform when installing,

servicing or removing the machine.

Use a secure secondary attachment such as a safety wire that can hold at least 10
times the weight of the machine.

Keep fingers and other objects out of the holes in the mounting brackets.

Rigging clamps, omega brackets, fasteners and safety wires are available as accessories from your
Martin supplier.

To suspend the fixture from a support:

1.

Ensure that any structure used to support the machine can support at least 10 times the total weight
of all installed fixtures, clamps, cables, auxiliary equipment, etc.

Ensure that all rigging clamps and fasteners are undamaged and can support at least 10 times the
machine’s weight.

Bolt a rigging clamp to the fixture’s flying bracket using a grade 8.8 (minimum) M12 bolt and lock nut,
or as recommended by the clamp manufacturer, through the 13 mm hole in the center of the
mounting bracket.

Loop a safety wire that can hold at least 10 times
the weight of the machine through/over the support
and around one of the four corner pillars that
connect the fixture’s upper and lower modules. Do
not simply loop the safety wire around the flying
bracket, as this will leave the fixture unsecured.

8mm

See illustration on right. Keep fingers and other
objects out of the holes in the mounting bracket.
Loosen the swivel lock Allen screws approximately
one full turn, tilt the fixture to the desired angle and
retighten the screws.

= 4mm

Ensure that fixture, rigging hardware and safety
attachment are secure and that the output window
is minimum 3 meters (10 ft.) above any publicly accessible floor before applying power.

Placing on a horizontal surface

The RGB laser 1.6 can be placed or permanently installed on a level horizontal surface resting on its
rubber feet.

To install the fixture on a horizontal surface:

1.

10

Ensure that the surface is level, stable and capable of supporting at least ten times the weight of the
machine.

Secure the machine so that it cannot slide, fall, or tilt, even if vibration from audio equipment or
another source is present.

Eliminate any risk of loss of alignment or contact by members of the public.
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Connecting to external devices

Connecting to a PC
The RGB Laser 1.6 can be connected to a PC running the Martin RGB Laser Show software via the 6-pin
XLR socket on the upper rear panel. Use the 6-pin XLR to USB adapter cable supplied with the fixture.

Note how connecting to a PC affects demo mode:

e Ifa PCis connected first and the RGB Laser 1.6 is then powered on, demo mode will be disabled
until the fixture is powered off and then on again with no PC connected.

e Ifa PC is connected after the RGB Laser 1.6 has been powered on, demo mode will be disabled until
the PC is disconnected again — in this case there is no need to power the fixture off and on to enable
demo mode.

Connecting to a DMX data link

The RGB Laser 1.6 DMX data connections are XLR type, wired with pin 1 to ground, pin 2 to signal -
(cold), and pin 3 to signal + (hot). This is the standard configuration for DMX devices.

To connect to the DMX data link:

1. Power all devices off.

2. Run a data cable from the DMX output of the DMX controller or the previous fixture on the data link to
the RGB Laser 1.6’s DMX IN socket

3. Either:
e run a data cable from the DMX OUT socket of the RGB Laser 1.6 to the IN socket of the next
fixture, or

e terminate the DMX link by inserting a 5-pin XLR male termination plug into the data output of the
last fixture. A termination plug is simply an XLR connector with a 120 Ohm, 0.25 W resistor
soldered across pins 2 and 3.

Connecting to an ILDA analog control device

The RGB laser 1.6 has a symmetrical ILDA standard 25-pin Sub-D input connector and a 1:1 wired 25-pin
Sub-D output (throughput) connector for connection to an ILDA control link.

ILDA analog Sub-D connector pinout

The pinout and maximum voltages for the ILDA standard Sub-D connectors are as follows:

Pin__Signal
1 | X+ (horizontal) +5.0V
2 | Y+ (vertical) +5.0V
4 | Interlock A

5 |Red+ +25V

6 | Green+ +25V

7 |Blue+ +25V

13 | Shutter +5.0V

14 | X - (horizontal) -5.0V
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15 | Y - (vertical) -5.0V
17 | Interlock B

18 | Red- -25V

19 | Green- -25V

20 | Blue- -25V

25 | Ground
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Operation

DANGER! Read ‘Safety Information’ on page 5 before operating the Martin RGB Laser 1.6.

Only Laser Safety Officers who are officially certified by a regulatory body or
authorized training organization are allowed to use the Martin RGB Laser 1.6. The
Laser Safety Officer is responsible for all aspects of use of this laser, including
ensuring that all locally applicable safety laws and regulations are observed. The
security key for the key switch must stay with the Laser Safety Officer at all times.

Before powering on or operating the RGB Laser 1.6, make sure that there will be no
risk from sudden exposure.

Do not allow people or objects to come within 2 meters (6.5 feet) of the RGB Laser 1.6
in the 80° horizontal, 80° vertical projection zone in front of the output window while
the fixture is connected to power.

Protect your eyes with laser safety goggles that are suitable for the RGB Laser 1.6
emissions listed in the specifications section of this manual when working on or near
the fixture, unless you have made sure that the fixture is powered off and that power
cannot be reapplied. Do not look directly into the output window or laser beam.

Use of controls or adjustments or performance of procedures other than those
specified in this user manual may result in hazardous radiation exposure.

Important! Lasers are sensitive to temperature conditions. Do not operate the RGB Laser 1.6 at

ambient temperatures below 5°C (41°F) or above 40°C (104°F), or you will cause
damage to the diodes that is not covered by the product guarantee.

Note that the heatsink between upper and lower modules can reach up to 55°C (131°F)
when operating at close to the upper ambient temperature limit.

Monitoring fixture status

DANGER! See illustration on right. When the EMISSION

The RGB Laser 1.6 has two feedback LEDs and a backlit LCD
display that allow you to monitor the status of the fixture:

LASER ON LED is lit, the laser is enabled and
can project a beam without any other warning.

EMISSION

|
The EMISSION LASER ON LED lights when the laser is \\ //
enabled, whether it is projecting a beam or not. It is an j \*
important safety indicator. / | \
The DMX and USB LEDs on the lower rear panel light when LASER

the fixture is receiving valid DMX data or there is a USB
connection to a PC respectively.

Martin Laser RGB 1.6 User Manual 13



Status messages in the display

When you power the fixture on at the main power switch, the fixture’s current status appears in the
display:

Status message Is displayed when...
Laser ...the keyswitch is in the OFF position, the interlock is open, or the housing is
off open
External ...the keyswitch is in the External position and the fixture will respond to ILDA
ILDA control signal input via the ILDA connector

...the keyswitch is in the DMX position, and the fixture is using its internal
Internal controller. The fixture will communicate with a PC running the Martin Laser
DMX: XXX Show software and accept DMX control signal input via the DMX connector

(XXX is the fixture’s DMX address)

Each time the keyswitch is turned to a new position, the display shows the new status.

If the interlock or the housing is open, the display shows Laser off regardless of keyswitch position.

Using the control panel and display

The RGB Laser 1.6’s onboard control panel and backlit LCD display allow you to read fixture status data,
adjust settings and set the fixture’s DMX address.

Control panel

The buttons grouped together on the control panel have the following functions:

DMX ADDR

The * and — (plus and minus) buttons scroll through the main menu. o % J Je F Fe Fe %

Main menu items are underlined with a line of stars *******%*

Once you have scrolled to the main menu item that you want to adjust, the A and
¥ (up and down) buttons scroll through the submenus.

Once you are in a submenu, the + and — buttons adjust values in the submenus.
These buttons have no effect in the Info menu because there are no values to
adjust.

The ENTER button in the center is used to start and stop selected cues in Demo
mode and to reset values in the Settings menu.
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Control menus

The table below

ives an overview of the menus, submenus and functions or values in the control panel.

Main menu Submenu Function/values
DMX ADDR
FekKkhdhkk 0-508
Software Current fixture software version.
Temp. ¢C Baseplate temperature.
Temp. ¢F Baseplate temperature (degrees Fahrenheit).
Info Total Hrs. Total hours of fixture operation.
falaiakaialaiaie LD Hrs. Total hours of operation of the laser diodes.
Power R Average power output in mW of red laser.
Power G Average power output in mW of green laser.
Power B Average power output in mW of blue laser.
Size X Horizontal size and orientation (flip): from -512 to +512
Default = +512 (100%).
Size Y Vertical size and orientation (flip): from -512 to +512
Default = +512 (100%).
Horizontal position: from -512 to +512
Offset X Default = 0 (center position).
Vertical position: from -512 to +512
Settings Offset Y Default = 0 (center position).
falaialelaiaiele Gain R Red laser gain 0 — 100%: 0 — 255
Default = 255 (100%).
- Green laser gain 0 — 100%: 0 — 255
Gain G Default = 255 (100%).
. Blue laser gain 0 — 100%: 0 — 255
Gain B Default = 255 (100%).
Press ENTER to set all the values in the Settings menu to
|
Enter to reset! default values.
Enter to
start XX Press ENTER to start the selected cue.
E:gerx)t(o Press ENTER to stop the cue that is currently running.
Demo B —
Khkdkdkk Tl Select page 1 — 8 from the pages of cues stored in fixture
p L XX memory (top line of display shows status message: see
age. next page).
Tr. Select cue 1 — 32 from the currently selected page of cues
Cue: XX (top line of display shows status message: see next page).

Martin Laser RGB 1.6 User Manual
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The following status messages are displayed in the top line of the display in demo mode:

Message Indicates that ...

IDLE ...the fixture is ready.

PLAY ...a cue is already running.

BUSY ...the fixture is receiving signals from a PC running Martin Laser Show

software or from a DMX controller (demo mode will become available again as
soon as the PC or the DMX controller is disconnected or powered off).

...either the fixture detected a connection to a PC at power on (demo mode is
disabled until the PC is powered off and on again with no PC connected),

DISABLED

........ ...or stand-alone autostart mode has been activated in the Martin Laser Show
software (demo mode is disabled until stand-alone autostart mode is de-
activated in the Laser Show software).

ERROR

...the internal memory is corrupt or incorrectly formatted

Fixture information readouts

The Info menu in the control panel has the following submenus:
o Software: Displays fixture’s internal firmware version.

o Temp. ¢C: Internal baseplate temperature. In normal conditions, this should stay between 24° C
and 28° C. If it falls below 15° C or rises above 30° C, the ambient temperature may be outside
the specified limits. If you do not bring the ambient temperature back to within the limits, the laser
may shut down. Displays A while the fixture is warming up, ¥ while the fixture is cooling down
and * when stable optimum temperature is reached.

o Temp. ¢F: Identical to above but in degrees Fahrenheit.

e Total Hrs. and LD Hrs.: Display the total number of hours of fixture operation and the
number of hours with laser diodes active since manufacture. These counters are not user-
resettable.

o Power R, Power G, Power B: Display power readings for red, green and blue laser diodes,
measured at the sources inside the fixture and averaged over several samples while the laser is
modulated..

Fixture settings and manual adjustment
As well as the adjustments available in the show software (see ‘Live control during playback’ on page 26),
fixture settings can be adjusted using the Settings menu in the control panel.

Adjusting offset and size for the x and y axes allows you to define your projection area and keep it within
safe limits. There are two advantages to setting your safe projection area manually in this way:

1. You no longer need to pay attention to the risk of projecting outside your safe projection area when
controlling offset and size (zoom) via the control desk.
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2. You have the full resolution of the DMX signal available to control offset and size (zoom) via the
control desk.

The following settings are available:

Size X and Size Y: Allow adjustment of the size of the projection. The default value is +512
(100%). At negative values the image is flipped (reversed left-to-right or inverted). Negative
value -512 gives a full-size flipped image. Flipping the image can be useful if the laser is being
used with a mirror or for back projection, for example. When using two fixtures, you can obtain
symmetrical effects by flipping the x axis on one fixture.

Offset X and Offset Y: Move the projection without affecting projection size. You can use
these controls to adjust the position of the projection to illuminate a specific area or avoid
projecting into the public. The default value is 0 (center position, no offset).

Gain R, Gain G, Gain B: Allow adjustment of color balance. The laser diode manufacturing
process means that it is quite normal for output power of the three different colors to vary by up to
+ 2.5%. Because of this, color balance adjustment may be necessary if you are running more
than one fixture and want to obtain the same white light color temperature from each fixture. The
default value is +512 (100%).

Enter to reset! As soon as this menu item is displayed, pressing the ENTER button in the
center of the control panel resets all the functions in the Settings menu to their default values.

Demo mode

The RGB Laser 1.6’'s demo mode lets you run cues 1 — 32 from pages 1 — 8 of the fixture memory without
an external controller and without setting the fixture to stand-alone mode in the Martin Laser Show
software.

Demo mode is NOT available:

if the fixture is receiving signals from a PC running the Martin Laser Show software

if the fixture has been powered on with a PC connected (it must be powered off then on again
with no PC connected before demo mode is available)

if the fixture is receiving signals from a DMX controller

if the fixture has been set up using the Martin Laser Show software so that it automatically plays
a cue at start-up (see Stand-alone mode on page 25).

Using the Martin RGB Laser Show Software

The Martin RGB Laser Show software package is supplied with the product. The most recent version of
the software can also be downloaded from the Support area of www.martin.com.

The Laser Show software allows you to

e Manage shows (save, backup, edit, transfer to storage media, etc.)

e Trigger cues by clicking on buttons with the mouse

e Upload frames or complete animations to the RGB Laser 1.6’s internal memory

e Create and edit the frames and animations online (real time editing)

e Control several parameters live during cue playback

e Update the fixture firmware

e Select a cue to run in stand-alone (autostart) mode

Martin Laser RGB 1.6 User Manual 17



If you use the show software online (i.e. with a Martin RGB Laser 1.6 connected and running), you can
view edited cues in real time.

If you use the show software offline, certain functions — such as uploading — are disabled, but you can
familiarize yourself with the software and prepare shows for upload at a later time.
Managing shows in workspaces

A workspace (*.sws) file contains all the elements of a laser show packaged into one single file.
Workspace files offer a convenient way of storing, backing up and transferring laser shows.

You can create a new workspace or open and save an existing workspace using the File menu.

Previewing and triggering cues, selecting pages

When you start the show software, the main window appears:

= MARTIN RGH | aser Showsolbware, Version 1.0 (build &63). Ediling workspace: “MARTIN DEFALIL T.sws" r:-_lﬁjm
Fbe Ed Yew Selbimp Lok Hedp
0 | Seacou X 28 Fea ol = LT L B |
Live Corbtol | Irdimmatuon:
= i
H Zoom H

|- =i s [

= Posilion and Rotakion

€3 Reven parsinan €D v onman,

= Coloa
M Fade H
[ Jpoce-
L] '1'|:|i-|x-I'. [ 1]
PE—T
H Coler "
L) T—
= Plaghack
M Arsmegtion 1peed H

Resrt Al Live Contsol Parameins

[\PAGE 1 JFAGE 2 JPAGL 3 IFAGE 4 JPAGE & PAGE GAPAGE 7 APAGE BAPM0E 7

| T

There are 48 cue buttons on each page. Each cue button carries an image of the cue’s projection on a
black background. Empty cues simply carry the word Empty.

The RGB Laser 1.6 is supplied with cues stored on pages 1 — 6. Pages 7, 8 and 9 are empty and
available for user-designed cues.

Click on any cue button that is not empty to preview or trigger that cue.

Pages are banks of cues. To change the active page, select one of the PAGE tabs 1 - 9 at the bottom of
the window.
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Creating, editing and importing frames and animations

To edit the content of a cue, select the cue and click on Edit in the toolbar (or right-click the cue and
select Edit from the pop-up menu) to open the Edit window. In this window you can create, edit and
import frames and animations. Select editing tools from the toolbar on the left.

Imported graphics will probably need to be processed and converted in suitable software such as 3D
Studio MAX and Lasershow Converter MAX from Pangolin Laser Systems, for example.

= Editing Page 1, Cue 18

File Edit View Transform Frame Qukput

= = B X = z.':‘."; Q a £k Effect 40 : %ﬁ-\nimate... Frame repeats |2 : — Density (%) 100 :
=

El=

M| T
T

{SHDISHGDHH 1D BiiHelsloiotetololotolololololel

O 38E6E:-115620:0 300 pairks Freehand
oK | Cancel |

When you have finished editing, click on OK to return to the main window.

If you made any changes to the cue, you will notice that the
cue button now has a floppy disk icon in the upper right
corner. The icon is a reminder that the content of the cue
has only been updated in the software and the fixture
memory still contains old data. You can preview changes to
cues while the floppy disk icon is displayed, but you need to
carry out an upload in order to synchronize fixture memory
with the software workspace.

To update internal memory with the changes, click on the Upload button on the toolbar or use one of the
Upload options in the Tools menu.
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Cue properties

To view or modify the properties of a cue, right-click on the cue button and select Properties... from the
pop-up menu.

You can now view or modify a number of parameters for the cue, including:

e Settings (projection size, animation type and zone, autostart setting)

e Output (sample rate and custom color settings)

e Vector settings (for advanced users)

¢ Information about the cue and memory usage

X

Cue properties

Settings l Dutput] Yectar settings] Infu:urmatiu:un]
Size
Size =[] 100 2
2
Size v [%] 100 2
2
Animation
Laop animation ﬂ
Animation duration; - Calculate duration |
Options
Praojectioh £one araphics ﬂ
[ Automatically play thiz cue after power up of FB3 SE board
AL L OK ] Cancel

Properties... = Settings
Size
Size X = Size X for this particular cue
Size Y = Size Y for this particular cue

Animation

Stop output at the end: The cue runs once and stops. If the cue only contains one frame, there will
be one very short flash whenever this cue is executed. This setting is therefore mainly useful for
multi-frame animations.

Loop animation: The cue runs in a loop and starts again automatically when it reached the end. It
continues looping until another cue is selected.
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Suspend on the last frame: The cue runs once and stops but holds the last frame of the animation.

Repeat last frame for duration, then terminate output: Similar to Suspend on the last frame, but
you can set how long the last frame is held by scrolling to a value in the Last frame duration box.
Possible times are 0.01 — 60 seconds.

Calculate duration: Clicking this box displays how long one frame takes to be projected. For
example, if it shows 0.30 and you have a cue with 10 pictures in the animation, it will run for 3
seconds.

Options

Projection zone: You can choose between four projection zones: Graphics, Atmosphere, Beam
Effects and User Defined. Choosing one of these projection zones for a cue applies the settings
defined for that zone in Settings > Geometric correction... to the cue.

To exploit this feature, adjust your projection area in the Settings > Geometric Correction... menu:
e to match the projection surface or screen in Zone 1: Graphics
e to project in a safe area above the public in Zone 2: Atmosphere Effects

e to project to a specific area (for example, an area where effect mirrors are placed) in Zone 3:
Targeted Beams

e to project to any other area you may wish to create in Zone 4: User defined.
Then choose which of these zones you want your cue to be projected in.

Checkbox: Automatically play this cue after power up of FB3SE board: Use this checkbox to set
up stand-alone (autostart) mode. If you check this checkbox for a cue, the cue will start automatically
after you apply power to the RGB laser if the keyswitch is set to DMX internal.

If you have selected a cue to be played automatically after power up, a colored A
star appears in the cue’s preview window (see illustration on right).

If you have linked cues in a loop, cues will play repeatedly after power up.

WAg R

in the new cue’s Properties... window. The old cue will automatically be Cue [
deselected.

To select a different cue to start automatically at power up, check this checkbox

Properties... 2 Output
Sample rate

Scan rate: You can adjust the scan frequency for a cue by entering its scan rate as a percentage of
the master scan rate setting (the master scan rate setting is defined in Settings - Projector
settings > Master scan rate). Possible values are 25% - 200%

Sample rate: You can adjust the scan frequency for a cue independently of the master setting by
entering its sample rate. Possible values are 5 — 30 K-PPS (kilopoints per second).

Overwrite projector color channels settings for this cue

If you check the Overwrite projector color channels settings for this cue checkbox, you can
adjust the color for this cue independently of the master color settings (the master color settings are
defined in Settings = Projector Settings > Master scan rate and Color settings). Red, green
and blue intensity can be adjusted from 0% to 100%.

Properties... =2 Vector settings

If you check the Overwrite projector Vector display settings for this cue checkbox, you can adjust
the vector settings for this cue independently of the master vector setting (the master vector setting is
defined in Settings - Projector Settings > Vector display settings).
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The vector settings options available for individual cues are the same as the master vector settings
options, and are explained under “Projector settings... = Vector display settings” on page 23.

Properties... = Information
This window displays information about the cue and memory usage.
Cue information shows the date the cue was last modified and the cue’s internal ID number.

If the laser is connected, Memory information shows the amount of memory used by the cue, total
memory capacity and how much memory capacity is still available.
Settings menu

The Settings menu contains two submenus:
e Projector settings

e Geometrical correction

Projector settings

Projector settings are master settings that are applied to all cues (except cues that have been given their
own custom settings in the Properties... window).

Projector Seitings E]

i Mazter Scan rate and Color settings l Vectar display seftings ]

Sample rate and Calar shift Output frame
Sample rate [FPPS] a0 -
. =
Colar zhift 10 -
. =
kirirnum points at autput 0 =
s =

Calar autput levels

Thiee laser [RGE] j
Fed channel intensity 100 <
pa
Green channel intensity 100 =
ra
Blue channel intenzity L= {* Test pattem 1 *
. potn [« | 5
" Current Cue J J
& (] | Cancel ‘

Before adjusting the projector settings, you may find it useful to read the following explanation of some of
the principles involved.

Due to the mechanical behavior of the projection galvos, the length of and number of points in a projected
line affect the projected image’s characteristics.
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A projected image is mapped as vector points to force the galvos to go to that point at maximum speed.
Effective speed depends on how many points are in a line. The more points a line has, the more precise
the projection, but the more it flickers.

The image map of a square only contains the square’s four corner points. Because of galvo inertia, raw
projected output will have a tendency to be circular rather than rectangular. The software can counteract
this tendency in two ways: firstly it can add points on the straight lines and secondly it can detect the
angle, note that the laser beam has to make a sharp change in direction, and add more points to the four
corner points to give the galvos enough time to change direction.

If you have two objects to project, the projection will follow a connection line between these two objects,
but with the laser dimmed to 0%. This is called a blank line.

Projector settings... 2 Master Scan rate and Color settings
Sample rate and color shift

Sample rate (K-PPS): Sets the master scan speed in kilopoints per second. Possible values are 5 —
30.

Color shift: Delays color modulation in relation to scanning. Modulation is faster than scanning, so it
has to be delayed and adjusted to match galvo movement. When color shift is correctly adjusted, the
color at the beginning and at the end of a scanned line will be the same. Possible values are 0 — 10.

Minimum points at output: Sets the minimum number of points the projector will use when
displaying an image. Blankpoints are added to an image if it contains fewer points than this minimum,
in order to keep the projection stable and avoid safety override by the scanner. Possible values are 8
—2000.

The more illuminated points a projected image contains, the brighter it will be. Blankpoints added to
an image are not illuminated and will reduce brightness. Therefore:

e If you have a small image that is made up of fewer points, it can be an advantage to set a lower
value for Minimum points at output. This will reduce the number of blankpoints added and
increase image brightness. However, if the image becomes too intense, the scanner will override
and cut output for safety reasons.

e If you have several separate objects, it can be advantageous to enter a higher value to
harmonize the brightness of each object.

Color output levels

Allows you to set laser type and adjust red green and blue channel intensity master settings for white
balance.

For the Martin RGB Laser 1.6, do not change the default laser type setting, i.e. Three laser (RGB).

Projector settings... 2 Vector display settings
Spacing

Visible lines spacing: The maximum allowed distance between two points in all visible lines. If the
distance between two points in an image exceeds the figure set here, the software will automatically
add points between these two points to make the projection more stable.

e If you increase this value, fewer points will be added. The result is increased scanning speed but
reduced precision and image quality.

e If you decrease this value, more points will be added. The result is higher projection quality but
reduced scanning speed.

Blanked lines spacing: The maximum allowed distance between two points in all invisible lines. If
the distance between two points in a blank line exceeds the figure set here, the software will
automatically add points between these two points to make the projection more stable.
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e If you increase this value, fewer points will be added to the blank line. The result is increased
scanning speed, but the start point of the next visible line might not be precise and you may see a
tail fading in.

e |f you decrease this value, more points will be added. The result is higher projection quality but
reduced scanning speed.

Anchors and Angle optimization

Visible Line begin: When a visible line begins, there will be one point to project. To force the galvos
to start at this point more precisely, you can overlay more points at the beginning of a visible line.

e If you increase this value, the line starts more precisely at the expected co-ordinates, but also will
become brighter because the laser stays at this point longer than at just one point. The point then
becomes a hotspot.

o |f you decrease this value, the laser may start projecting before the galvos reach the correct co-
ordinates.

Visible Line end: When a visible line ends, there will be one point to project at the end. To force the
galvos to reach the end of the line more precisely you can overlay more points at the end of the
visible line.

e If you increase this value, the line ends more precisely at the expected co-ordinates, but also will
be brighter at this point.

e |f you decrease this value, the laser may stop projecting before the galvos reach the correct co-
ordinates and a fade out tail may be seen at the end of the line.

Visible Corner: If the software detects a sharp angle, it will add/overlay more points at this set of co-
ordinates. You can adjust how many points are added here.

e |If you increase this value, more points will be added and the corner will be sharper.
e If you decrease this value, fewer points will be added and the corner will be more rounded.

Linear angle to anchor relation: Sets the threshold for when an angle is detected as a sharp angle
and the software starts to add points.

Blanked Line begin: Same as Visible line begin, but for blank lines.
Blanked Line end: Same as Visible line end, but for blank lines.

Test pattern: This fader lets you choose from a range of standard test patterns to make it easier to
adjust the vector display settings.

Current Cue: This fader displays the currently selected cue so that you can make adjustments while
watching the cue.

Geometrical Correction

The geometrical correction options in the Settings menu allow you to modify image geometry. They are
useful for setting the limits of projection zones and matching images to the characteristics of the
projection surface (compensating for keystoning, for example).

You can define geometrical settings for each of the projection zones that you can route cues to. A logical
way of exploiting this feature is to adjust your projection area:

24

e to match the projection surface or screen in Zone 1: Graphics
e to project in a safe area above the public in Zone 2: Atmosphere Effects

e to project to a specific area (for example, an area where effect mirrors are placed) in Zone 3:
Targeted Beams

e to project to any other area you may wish to create in Zone 4: User defined.
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Moving cues

To move a cue, simply click-and-drag to a new location on the page.

To move a cue to a different page, click and drag the cue button down onto the tab for the page you want
to move it to. The window for the new page opens, and you can continue dragging the cue button up to a
location on that page.

If you try to move a cue to a location that already contains a cue, the software asks you to confirm that
you want to overwrite the existing cue.

You can also copy, cut and paste cues to new locations in the Edit menu.

Linking cues

You can set one cue to automatically follow another as a chaser by creating a link. To create a chaser:
1. Select the first cue.

2. Activate the link command, either in the Edit menu, by right-clicking on the cue and selecting Link, or
by clicking on the Link icon in the toolbar at the top of the main window.

The cursor turns into an arrow. Point it at the cue you want to link to and click.

The cue you linked to will now automatically follow the first cue. The link is displayed at the bottom of
the cue button. (Example: Cue 01 > 02).

Continue linking to add cues to your chaser.

To create a loop, link the last cue in your chaser to the first.

Stand-alone mode

In stand-alone autostart mode, the RGB Laser 1.6 runs a cue automatically when it is powered on. To
activate this mode:

1. Right-click on the cue and click on Properties... in the drop-down menu.

2. At the bottom of the Properties window, mark the checkbox: Automatically play this cue after
power up of FB3 SE board.

[v itutamatically play thiz cue after power up of FB3 SE board

3. Upload the cue to the fixture using the Tools menu.

The selected cue will now play automatically when the fixture is powered on. Note that it will also play
automatically during DMX operation if Page selection and Cue selection channels are both set to zero.

If you have linked cues in a loop, the looped chaser will play continuously.

Note that demo mode is not available when stand-alone autostart mode has been activated.

Uploading cues from your PC to the fixture

If you have modified cues and settings on your PC, use the Tools... 2 Upload 432 cues... command to
upload the cues and settings to the fixture’s internal memory.

To upload only one cue and leave the other cues in the fixture’s memory unchanged, use Tools... >
Upload “Cue XX” only (where XX is the number of the currently selected cue).

Martin Laser RGB 1.6 User Manual 25



Live control during playback

The show software allows live control of several parameters in real time during cue playback. Live
controls are accessed in the side panel to the right of the main window. The side panel contains two sub-
panels, Live Control and Information, which are selected using tabs above the panels.

In the Live Control sub-panel you can control:
e Zoom (size) e Caad | T RICB
e X Position

¢ Y Position > 2008 'I
e X Rotation _“ } —En!:rn _ “l

.Y Rotton | T 0
* ZRotation ~ Position and Rotation .

e Brightness 11

e Visible points

e Color

¢ Animation speed

e Scan rate

) Reset posiion - €D Reset rotation

- o .

M . Fade M|
- T e |
M _ Visble poinits i
| — |
il (e 2L
Een T )
= Plagback

M Animation speed M ||
B e 1)

4 Scantate 9]

|__. | I ._....__.-—...__.

Heszet All Live Control Parameters |
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DMX operation

See the DMX Protocol included as Appendix 1 at the end of this manual for a complete overview of DMX
modes, channels used and control options available.

Check that the RGB laser 1.6 is correctly and safely installed. If so, power up at the fixture’s power on/off
switch. If the fixture resets and starts up successfully, the fixture’s DMX address appears in the display.

Setting DMX addresses

Basic principles

The DMX address of a fixture is the first channel used to receive control data within the range of 512
physical channels available in one DMX universe. If the fixture is set up to use 16 channels, for example,
it will respond to commands on this first channel and the next 15 channels. Thus, if the DMX address is
set to 48, channels 1 - 16 on the fixture will correspond to physical channels 48 - 63 at the DMX
controller.

To avoid unexpected behavior, make sure that channels used by different fixtures do not overlap. In the
example above, channel 64 is available as the DMX address for the next fixture.

Fixtures of the same type with the same DMX address will respond identically to commands from the
control desk.

Allow enough channels for the fixture out of the 512 available. If the fixture is set up to use 16 channels,
for example, the highest value you should set as DMX address is the first of those 16 channels, i.e. 497.

Setting a fixture’s DMX address

DANGER! Before changing the DMX address, set the keyswitch to the OFF position to avoid
accidental exposure.

The RGB Laser 1.6’'s DMX address is set manually using the control panel and display.

To set the fixture’s DMX address:

Set the keyswitch to the OFF position to avoid accidental exposure if the fixture reacts unexpectedly.
Press the + button repeatedly until DMX ADDR appears in the display

Enter the DMX address submenu by pressing the UP button or the DOWN button once.

Set the fixture’s DMX address by using ¥ to increase or — to decrease the address

A short blink in the display illumination will show that the new value is stored

o gk~ 0N~

After setting the DMX address, check that there is no possibility of accidental exposure before turning
the key switch to the INTERNAL DMX position.

Selecting a DMX mode

The RGB Laser 1.6 offers a choice of four DMX control modes. It uses 4 DMX channels minimum and 16
channels maximum, depending on which DMX control mode is selected:

e Basic mode uses 4 DMX channels

e Standard mode uses 8 DMX channels
e Extended mode uses 12 DMX channels
e Full mode uses 16 DMX channels

The DMX mode is selected by sending a corresponding DMX value on fixture channel 1.
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Show selection via DMX

If you are using an analog DMX desk, it is not possible to place all 432 possible show selections on one
channel with 256 possible fader positions. The Player therefore uses two channels for show selection,
one channel to select a Page, and the next channel to select a cue from the current Page. Pages can
therefore be considered as banks.

To select a show:
e On channel 2 (PAGE), select a Page from 1-9 in the show software.
e On channel 3 (CUE), select one of the 48 Cues on the selected Page.

If you set both channel 2 and 3 faders to zero, show output stops unless you have set the fixture to run in
stand-alone mode with DMX connected (see next section).

Running in stand-alone mode with DMX connected

When the RGB Laser 1.6 is receiving a DMX signal, stand-alone operation is disabled by default. To set
the fixture to play in stand-alone mode when it is still connected to a DMX controller:

1. Right-click on a cue

2. Choose Properties... from the drop-down menu.

3. Put a check in the checkbox Automatically play this cue after power up...

4. Move channel 2 (PAGE) and 3 (CUE) faders to zero to play the cue in stand-alone mode.

Note that this cue will also play when you power the fixture on and it is not receiving a DMX signal.
DMX failure protection

The RGB Laser 1.6 automatically recognizes a valid DMX signal. If the signal fails because the DMX link
is broken or disconnected, or if the DMX controller stops sending a valid DMX signal, output is shut down.

ILDA operation

The RGB laser 1.6 has a standard symmetrical ILDA input interface.

Any type of show controller with a symmetrical ILDA output can be connected to the fixture using a 1:1
25-pin Sub-D cable.

Make sure that your controller supports a +5 V Shutter signal at Pin 13.

A controller with non-symmetrical signals can be used if all negative input pins (14, 15, 18, 19, and 20)
are connected to ground.

Important! The signals for x and y must not exceed +10 V and the signals for RGB must not
exceed +5 V with reference to ground at any time!

After connecting your ILDA-compatible controller, power up the fixture and turn the key switch to the
EXTERNAL position.
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Service and Troubleshooting

DANGER! Protect your eyes with laser safety goggles suitable for the emissions from the fixture
as described in the Specifications section at the end of this manual when working on
or near the fixture, unless you have made sure that the fixture is powered off and that
power cannot be applied accidentally. Do not look into the output window or laser
beam.

Important! This fixture contains no user-serviceable or adjustable parts. Do not try to open the
sealed dust-free optical module — doing so will destroy the optical coatings inside the
fixture, allow dust to enter the module and invalidate the product guarantee. Even one
speck of dust can cause serious damage to the laser.

Cleaning

Warning! Do not use water or any other liquid to clean the fixture.
Wipe the housing of the fixture with a damp (but not wet) cloth if necessary.

To maintain adequate cooling, dust must be cleaned from the fan and air vents periodically. Check and, if
necessary, clean fixtures at regular intervals.

To clean the fan and air vents:
1. Disconnect the data and power cables and allow the fixture to cool for at least 5 minutes.

2. Remove dust and dirt from the fan blades, vent grill and heatsink using a soft brush, cotton swab,
vacuum, or compressed air.

Replacing fuses

Warning! Do not bypass a fuse or replace it with one of another size or rating.

The RGB laser 1.6 uses two slow-blow 2.5 amp main fuses for protection against current overload. An
indication that a fuse may have blown is that when power is applied, the LCD display does not light up
and fans do not run.

If the fuse blows repeatedly, there is probably a fault. Disconnect the fixture from power and data and
contact a Martin service technician.

To replace a fuse:
1. Disconnect the power cable.

2. Open the fuseholder (located next to the power cable entry) with a flat-headed screwdriver and
remove the fuses for testing.

3. Replace a defective fuse with a new 2.5 A slow blow, 5 x 20 mm glass-type fuse (available from
Martin, P/N 05020010).

4. Replace the fuseholder before reconnecting to power.

Firmware updates

If new firmware is released, it is included in a new version of the Martin RGB Laser Show software and
made available on the Martin website at http://www.martin.com

When the show software is connected to the fixture, it checks the fixture’s firmware. If it detects an older
version, it displays a dialog box asking if you would like to update it. Click OK to allow the show software
to automatically update the firmware.
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Martin RGB Laser 1.6 Specifications

Physical
SiZE (L XW X H) e 290 x 204 x 178 mm (11.5x 8.1 x7.0in.)
Height with bracket attached ... 260 mm (10.3 in.)
Length with bracket attached ... 326 mm (12.9in.)
L7 LT T 1 USSR 11.2 kg (24.7 Ib.)
Control and Programming
Control options .......ccooeeviiiiiiiiiieeeeees DMX, ILDA, PC software (supplied), stand-alone autostart mode
R To 11U o] =T o Lo I PP PRR 12-bit
ReSOIULION RGB INTENSITY ...oeiiiiiiiiiiiii et e e e e e et e e e e e e e e e snnraaeee e e e s nnnnneees 8-bit
1Y Do o F= T ] 1= PR 4,8,120r 16
DEMO SEQUENCE .....ooeiiiiiieiiiiiie e Storage for 256 cues, can be edited/overwritten
Stand-alone MEMOTY .......cooi i e 128 MB, 432 linkable/loopable cues
DMX address Setting ..........uevvveeieiiieieiiiiiiiiiniieeaees Onboard control panel with backlit LCD display
Stand-alone ProgramMING ..........oicueieeiiiiieeieieee et e e e ateeeesateeeeestaeeeesnbeeeeeanseeeeeaasseeeesanseeaeaans PC software
Projection settings and data readouts................cccccccoo. Onboard control panel with backlit LCD display
L (0] (oo USRS USITT DMX512-A
Laser
L7 =TS 4
LI/ <L UPPRRPPRRP Diode laser, cw-emission
PA 440 NM-660 NIM Lottt et ennre e e s max. 2000 mW cw
WHhite lIGht QULPUL..... .ot e e e e e e e e e e e e e e e e e e e e nneneees 1.3 W
=D 0 10T T 0 U1 o T | SRR 1.6 W
ST Lo o LY=o =T o o= PRSP 0.8 mrad
Wavelengths
=T PR 650 nm +/-5 nm
L€ =TT o T O PSP T PSP PP UPSPOPPP 532.5 nm +/-0.5 nm
BIUE .t — e et e e e e —ee e e e nrte e e e naeeeeanteeeeenaeeennnees 446 nm +/-3 nm
Projector
Projection angle NOFiZONTaL ...............uueiiiiiiii e e e e e e e e e e e e 80°
Projection @angle VEIICAL ..........o et e e e e e et e e e e e e e e e te e e e e e e e nnneeeeeas 80°
SASRT (StEP reSPONSE HIME)...cei it 0.3 ms
Construction
[ [ 10 ] o T PR SRPP Aluminum
0 o OSSPSR Black
INGress ProteCtion rating ........ooueiii et et e e e e e IP 52
Installation
L@ 41T 1 e= i o] o B PP PRI Any
Minimum distance to persons and objects in beam zone ............ccccooviiiiiiii i 2m(79in.)
Minimum height above publicly accessible floor ............cccvvviiiiiiiii e 3m (10 ft.)
Minimum distance to illuminated SUMacCES ..........cccceiiiiii i 2m(79in.)
Minimum distance to combustible materials .............ocei i, 1m (40 in.)
Minimum clearance arouNd AEVICE...........ooiuuiiiiiiiiiie et 30cm (12in.)
Relative humidity IMItS..........oooiiiiii e 0 — 90% non-condensing
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Connections

AC POWET INIET ...t 3-prong IEC male socket
ANAIOG (ILDA) INJOUL ...ttt et e e s e e es 25-pin Sub-D
1Y T 7o T | PR 5-pin locking XLR
Programming and uploads...........cccceeeeeiiiiiiieccce e USB 2.0 (via 6-pin XLR chassis connector)
Electrical
O oo Y SRR 100-240 VAC nominal, 50/60 Hz
Power supply Unit.........oooiiii s Auto-ranging electronic switch-mode
Main fUSES ..ooeiiiiiie e 2.5 AT (slow blow), 5 x 20 mm glass type, P/N 05020010
Maximum power and current
TOOV, BOHZ....eeee ettt e e e e ettt e e e sttt e e e sttt e e e s anbeeeeeanbeeeeeanbeeeeeaneaaeann 1.8 A, 180 W
TAOV, BOHZ...eeeeeeeeee ettt e e e et e e e st e e e sttt e e e abteeeeaanteeeeeantaeeeeanteeeeeaneeaeeanns 1.7A,180 W
TABV, BOHZ...oeeeeeeeee et e et e e e et e e e sttt e e e eette e e e aanbaeeeeanraeeeearaeeeeanreaeeanns 1.7A,180 W
T20V, BOHZ....oo et e e e e et e e e et e e e e eeab e e e e aaab e e e e e aabeeeeeabaaeeeareaaeaans 1.7A,180 W
220V, BOHZ ...ttt et e e e bt e e e aan et e e e e teeeeeanreeeeeateeaeann 0.7A,180 W
230V, BOHZ...eeeee ettt et e et e e e et e e e e e bttt e e aanteeaeeantaeaeeanteeaeeaaeaeeanns 0.7 A, 180 W
240V, BOHZ....eeeeeeeee ettt e et e e e e e e e et e e e e e eate e e e et teeeeaantaeeeeataeeeeanaeaaeanns 0.7 A,180 W
Measurements taken at nominal voltage. Allow for +/-10% variation.
Thermal
Maximum ambient temperature (Ta) .. ..o e 40° C (104° F)
Minimum ambient temperature (Ta) ..ooooviieee i 5° C (41° F) non-condensing
Recommended storage temperature ............ooveoiiiiiiiiiiiie e 20-25° C (68-77° F)
Acoustic
Sound pressure level...........ccccooiiiiiei, <42 dBA at 1 m, (3.3 ft.), steady state, Ta 25°C (77° F)
Approvals
\WTERTE,
C € C@Ib us
LisTED
LU SIS 7= 1] 4TSRS IEC 60825-1/ FDA Laser Notice 50
US Federal standard ............oooouviiiiiiiiee et 21 CFR 1040.10 and 1040.11(c)
Canadian Safety .........c.eeeiiiii s CSA C22.2 No. 60950-1
EU Safety ..o EN 60950, EN 60825-1
EUEMC ..., EN 55022, EN 55103-1, EN 55103-2, EN 61000-3-2, EN 61000-3-3

Included items
CD with Martin RGB Laser Show software, default cue library and fixture firmware (backup copy)

Two security Keys for KEY SWItCN..........uviiiiiiii i P/N 50521000
INtErlock CONNECIOT (AMP).......eiiie e e e e et e e e e nree e e e nees P/N 05347230
Adjustable MoUNtING YOKE .........oiiiii e P/N 56600069
5 meter (16 ft.) 6-pin XLR to USB adaptor cable

3 m power cable, IEC, SChUKO PIUG ...coiiiiiiieeieee e P/N 11501020
1.8 m power cable, IEC, US PIUG .....oiiiiiiiieiiiiie et et e e e e e e P/N 11501502
1.8 m power cable, IEC, WithOUt PIUG.....ccooiaiii e P/N 11501010
L LYY g 0 =T T | SRR P/N 35000189
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Ordering Information
Martin RGB Laser 1.6 (in cardboard DOX).........coccuuiiiiiiiiieiiiiiee s e e e P/N 90432000
Martin RGB Laser 1.6 (in flight Case) .......oocueiiiiiiiii e P/N 90432001

Specifications subject to change without notice
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Appendix 2: Warning Label Location and Identification

When supplied, the Martin RGB Laser 1.6 is fitted with the warning labels illustrated below.

Warning! Do not cover these warning labels with sticky tape, labels, etc.

Laser radiation waming label

Emission indicator

LASEM FADLATC 15 EMTTED
FHOM TS APERTLRE

EMISSION

LASER ON

Martin RGB Laser 1.6
Warning and classification label

LASER RADIATION
ANDIID EYE OR SKIN EXPOSURE TO . .
DIRECT OR SCATTERED RADIATION . _— !

CLASS 4 LASER PRODUCT
EM 80825 1:2001:11
\ 4

-

e -

Housing interlock label

DANGER

LASER CLASS 4 RADIATION WHEN OPEM
AND INTERLOC KS DEFEATED.

ANDID EYE OR SKIN EXPOSURE TO
DIRECT Of SCATTERED RADIATION.




